Bluebeam Revu
PDF Markup & Collaboration
Bluebeam Revu

Idaho Transportation Department
3311 W. State Street P.O. Box 7129
Boise, ID 83713

If you need assistance with Bluebeam, please contact the OTS Support Team:

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>Benjamin Daley</td>
<td>(208) 772-8033</td>
<td><a href="mailto:Benjamin.Daley@itd.idaho.gov">Benjamin.Daley@itd.idaho.gov</a></td>
</tr>
<tr>
<td>D2</td>
<td>Janet Zarate</td>
<td>(208) 799-4243</td>
<td><a href="mailto:Janet.Zarate@itd.idaho.gov">Janet.Zarate@itd.idaho.gov</a></td>
</tr>
<tr>
<td>D3</td>
<td>Marc Danley</td>
<td>(208) 334-8389</td>
<td><a href="mailto:Marc.Danley@itd.idaho.gov">Marc.Danley@itd.idaho.gov</a></td>
</tr>
<tr>
<td>D4</td>
<td>James Bennett</td>
<td>(208) 886-7818</td>
<td><a href="mailto:James.Bennett@itd.idaho.gov">James.Bennett@itd.idaho.gov</a></td>
</tr>
<tr>
<td>D5</td>
<td>Kelli Baker</td>
<td>(208) 239-3363</td>
<td><a href="mailto:Kelli.Baker@itd.idaho.gov">Kelli.Baker@itd.idaho.gov</a></td>
</tr>
<tr>
<td>D6</td>
<td>Brad Richards</td>
<td>(208) 745-5635</td>
<td><a href="mailto:Brad.Richards@itd.idaho.gov">Brad.Richards@itd.idaho.gov</a></td>
</tr>
<tr>
<td>Bridge</td>
<td>Rick Jensen</td>
<td>(208) 334-8589</td>
<td><a href="mailto:Rick.Jensen@itd.idaho.gov">Rick.Jensen@itd.idaho.gov</a></td>
</tr>
<tr>
<td>HQ</td>
<td>Beau Hansen</td>
<td>(208) 334-8494</td>
<td><a href="mailto:Beau.Hansen@itd.idaho.gov">Beau.Hansen@itd.idaho.gov</a></td>
</tr>
<tr>
<td>HQ</td>
<td>Jeremy Hunting</td>
<td>(208) 332-7167</td>
<td><a href="mailto:Jeremy.Hunting@itd.idaho.gov">Jeremy.Hunting@itd.idaho.gov</a></td>
</tr>
</tbody>
</table>

For More Information:
ITD SharePoint CADD/ProjectWise
CADD/ProjectWise/Bluebeam

Helpful links:
BlueBeam Training Materials
BlueBeam Support
BlueBeam Revu Basics
BlueBeam Revu 2016 Tips and Tricks
Collaborative Design Review in Bluebeam Studio

Revision date: October 2017
Introduction to Bluebeam Revu

This course will teach you how to use Bluebeam Revu for your PDF markup and collaboration needs.

Bluebeam Revu provides powerful and easy to use features for marking up Architecture, Engineering, and Construction (AEC) plan PDF documents. The Studio Session feature allows users from any location to participate in a collaborative review. Bluebeam makes use of Amazon Web Services (AWS), commonly referred to as the Amazon Cloud. This service will host the documents for the Studio Session.

There are two roles within a Bluebeam Studio Session: initiator and participant. If you are going to initiate a Studio Session you need to have any tier of Bluebeam Revu installed on your pc. However, to be a participant all that is required is Bluebeam Vu (a free PDF reader), though Bluebeam Revu can be used as well.

<table>
<thead>
<tr>
<th>Initiator</th>
<th>Install Bluebeam Revu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participant</td>
<td>Install free Bluebeam Vu download (unless the participant already has Bluebeam Revu)</td>
</tr>
</tbody>
</table>

Course Objectives for Bluebeam Revu

*At the conclusion of this course, you will be able to:*

- Navigate the Interface
- Add Markups to a PDF
- Calibrate and Make Measurements on a PDF
- Insert, Delete, and Crop Pages of a PDF
- Perform PDF Comparisons
- Combine and Convert Multiple PDF files
- Initiate, Join, and Finish Studio Sessions
- Manage Studio Session Permissions
- Customize the Interface

If you need additional help, email the ITD Support Desk at service.desk@itd.idaho.gov.
# Table of Contents

Chapter 1: Interface......................................................................................................................... 3
  Interface Overview ..................................................................................................................... 3
  Navigation .................................................................................................................................. 4
  Status Bar .................................................................................................................................... 5
  Command Bar Groups ................................................................................................................ 6
    File.......................................................................................................................................... 6
    Edit ......................................................................................................................................... 6
    View ....................................................................................................................................... 7
    Document ............................................................................................................................... 7
    Markup ................................................................................................................................... 7
    Measure .................................................................................................................................. 8
    Window .................................................................................................................................. 8
    Help ........................................................................................................................................ 8
  Tabs ............................................................................................................................................ 9
    Properties Tab ........................................................................................................................ 9
    Thumbnails Tab.................................................................................................................... 13
    Bookmarks Tab .................................................................................................................... 13
    Search Tab ............................................................................................................................ 15
  Working with Profiles .............................................................................................................. 16
  Preferences ................................................................................................................................ 17
    General ................................................................................................................................. 18
    Grid & Snap .......................................................................................................................... 19
    Markup ................................................................................................................................... 20
  Navigation ................................................................................................................................ 22
  Studio ................................................................................................................................... 23
Chapter 2: Commenting & Markups............................................................................................. 27
  Compatibility ............................................................................................................................ 27
  Markup Overview ..................................................................................................................... 27
  Markup Tools ........................................................................................................................... 27
    Text Menu ............................................................................................................................ 28
Pen Menu.............................................................................................................................. 28
Lines Menu........................................................................................................................... 29
Shapes Menu.......................................................................................................................... 29
Sketch................................................................................................................................... 30
Image and Image Menu......................................................................................................... 31
Camera ................................................................................................................................. 31
Hyperlink and Hyperlink Menu............................................................................................ 31
Attachment ............................................................................................................................ 31
Stamp Menu .......................................................................................................................... 32
Measurement Setup ............................................................................................................. 33
Calibrating a PDF.................................................................................................................. 33
Working with Viewports....................................................................................................... 34
Measurement Tools ............................................................................................................. 36
Measure Tool....................................................................................................................... 36
Calibrate............................................................................................................................... 36
Linear Menu........................................................................................................................ 36
Area.................................................................................................................................... 36
Volume............................................................................................................................... 36
Cutout................................................................................................................................. 37
Count................................................................................................................................. 37
Geometric Menu............................................................................................................... 37
The Tool Chest ..................................................................................................................... 39
Using Tool Sets................................................................................................................... 39
Reusing Recent Tools........................................................................................................... 40
Properties Mode vs. Drawing Mode....................................................................................... 42
Pinning a Tool Set............................................................................................................... 44
Markups List......................................................................................................................... 45
Markups List Button Bar....................................................................................................... 45
Markups List........................................................................................................................ 46
Expanded List..................................................................................................................... 47
Collapsed List.................................................................................................................... 47
Partially Collapsed List ................................................................. 47

Chapter 3: Document Manipulation ....................................................... 55

Insert ......................................................................................... 55

Extract ..................................................................................... 56

Crop ........................................................................................ 56

Document Comparison ........................................................................ 57

Comparing Two Versions of the Same Document or Drawing ................. 57

Defining Documents A and B ......................................................... 57

Optionally Defining a Region ........................................................ 57

Aligning the Documents ................................................................ 57

Defining the Appearance of Markups .............................................. 58

Choosing Other Options ................................................................ 58

Deskew Using Page Setup ............................................................ 61

Deskew Using the Keyboard .......................................................... 62

The Deskew Toolbar Button .......................................................... 62

Chapter 4: Studio Session ................................................................. 65

Studio Session: Create, share and collaborate in the cloud ................... 65

Host a Studio Session .................................................................... 65

Start a Session (Outside of ProjectWise) ......................................... 66

Start a Session (Inside ProjectWise) ................................................ 68

Manage a Session ........................................................................ 69

Attendee Access .......................................................................... 69

Manage Documents ....................................................................... 71

Limitations of Bluebeam during a Studio Session ............................ 71

Create a Report ............................................................................ 72

Finish a Session ........................................................................... 74

Appendix ..................................................................................... 78

Register / Unregister ..................................................................... 78

Default PDF Associations ............................................................. 79

Setting the default PDF reader in ProjectWise ................................. 79

Setting the default PDF reader in Windows ..................................... 81
Chapter 1:
Bluebeam Revu Interface
This chapter delves into the following topics:

✓ Become familiar with the Bluebeam interface
  Properties Tab

✓ Navigation
  Pan
  Select
  Zoom
  Thumbnails
  Bookmarks

✓ Searching
  Text
  Visual

✓ Profiles

✓ Preferences
Chapter 1: Interface

Interface Overview

At the top of the Revu window you will see the Command Bar. The Command Bar provides access to tools and commands organized by group. Below the Command Bar and to the right edge are optional Toolbars. These toolbars provide customizable, one-click access to the tools you need most. To turn on or off toolbars, on the Command Bar click View, then click Toolbars.

There are three Panels around the Main Workspace which contain a number of tabs. These tabs provide quick access to tools for viewing, navigating, annotating and gathering information from a PDF. Revu provides Left, Right, and Bottom Panels and places commonly used tabs in them by default, but you can freely move any tab to any panel, and it is even possible to detach a tab into a floating panel for more flexibility. To detach a tab, click and drag it off the panel area. Once you create a floating panel, any number of tabs may be added to the panel.
Below the Main Workspace but above the bottom panel, notice the Navigation Bar, which contains tools to help navigate documents. This bar is customizable like a Toolbar. At the very bottom of the application window, below the bottom panel, sits the Status Bar, which contains additional information and tools to help you interact with PDFs smoothly.

**Navigation**

The Navigation Bar is located between Revu's Main Workspace and the Bottom Panel. The Navigation Bar enables efficient movement between pages and views in the Main Workspace.

1. **Unsplit**: Eliminates the current split.
2. **Split Vertical**: Engages MultiView™ and divides the workspace into two vertically oriented splits.
3. **Split Horizontal**: Engages MultiView™ and divides the workspace into two horizontally oriented splits.
4. **One Full Page**: A single page of the PDF displays. *The mouse wheel will zoom in and out of the page.*
5. **Scrolling Pages**: Pages of the PDF files display in a column. *The mouse wheel will scroll up and down the pages.*
6. **Pan** (Esc or Shift+V): Click and drag to pan the image.
7. **Zoom** (Z): Click to zoom in; hold Ctrl and click to zoom out.
8. **First Page** (Home): Jump to the first page of the PDF.
9. **Previous Page** (Ctrl+Left): Go to the prior page of the document.
10. **Next Page** (Ctrl+Right): Go to the next page of the current document.
11. **Last Page** (End): Jump to the last page of the document.
12. **Previous View** (Alt+Left): Go back to the previous view in the main workspace.
13. **Next View** (Alt+Right): Go to the next view in the main workspace.
14. **Dimmer**: Dims down PDF so you can better see markups.
Status Bar

The status bar is located at the bottom of the Revu desktop. The left side includes prompts to help you use the current command or tool. The right side includes the size of the current PDF page and the current cursor position.

To display the Status Bar:

- Press F8

-or-

- On the Command bar, click View > Interface > Status Bar.

There are six toggle buttons in the middle that switch features on and off:

**Grid** (Shift+G): Displays the visible grid to aid in placement of markups. The grid spacing is configured through the Preferences. Click Settings/Preferences/Grid & Snap.

**Snap** (Ctrl+Shift+F9): Forces the cursor to move along the defined document grid. The grid spacing is configured through the Preferences. Click Settings/Preferences/Grid & Snap. The grid can be made visible by toggling on the Grid button on the Status Bar or in Settings.

**Content**: Toggles whether or not elements of markups will snap to underlying content. The snap will connect to the endpoints or the midpoints of the elements. Change the settings for this option in Preferences. Click Settings/Preferences/Grid & Snap.

**Markup**: Toggles whether markups will snap to other markups when they are created.

**Reuse**: Enables the same markup to be added to the PDF without having to reselect the button on the toolbar. This mode is helpful when adding the same markup onto the PDF sequentially.

**Sync**: Synchronizes the two viewing windows when displaying the PDF in side-by-side Split View mode or in a detached window. This is useful when you need to compare two different versions of the same document. Moving the document in one window will automatically adjust the view in the second window.
Exercise 1.1 – Docking panels

1. Expand the Left Panel and select the File Access tab
2. Click-and-drag the File Access tab to the Right Panel and continue to hold down the mouse button
3. Hover over the Up Arrow, then release the mouse button
   *Observe how the Right Panel is split in half with the File Access tab on top, and the Properties tab on the bottom*
4. Click-and-drag the File Access tab back to it’s original position in the Left Panel

Command Bar Groups

As mentioned earlier, groups of menu buttons display in the center or the Command Bar and are interchangeable depending on the Menu you have selected. There are nine menu groups:

**File**

The File group contains menus buttons associated with creating, combining, importing and exporting, and batch processing documents.

![File Command Bar Groups](image)

**Edit**

The Edit group provides menu buttons pertaining to object and text manipulation.

![Edit Command Bar Groups](image)
**View**

The View group contains menu buttons to change the look of the workspace and open documents.

![View group menu buttons]

**Document**

The Document group provides menu buttons for working with PDFs.

![Document group menu buttons]

**Markup**

The Markup group contains menu buttons for adding markups to a PDF.

![Markup group menu buttons]
**Measure**

The Measure group contains the Measurement and Calibration tools plus quick access to the various measurement modes.

![Measure Tools](image)

**Window**

The Window group includes menu buttons for controlling the main workspace window.

![Window Tools](image)

**Help**

The Help group contains menu buttons that link to help and other resources.

![Help Tools](image)

**Exercise 1.2 – Reviewing the Help menu**

1. Select the Help group on the Command Bar
2. Click on the Resources button
3. In the resulting WebTab, click on SUPPORT
4. Select the desired help option from the list

For additional help, refer to the Helpful Links section or contact your ITD Bluebaum Contact
Tabs

The three attached panels and any floating panels you have created can hold a number of powerful, specialized tabs, which provide efficient access to a variety of Revu features. This section covers the most used tabs and the functionality each enables.

Properties Tab

The Properties tab displays any attached files and metadata about the currently active PDF. If a markup or group is selected, the Properties tab will display the specific appearance of the selected markup or group. By default, the Properties tab appears in the right panel.

To display the Properties tab, click properties or press Alt+P.

File Properties Sections

If no markup is selected, the currently active file's properties are displayed in the Properties tab.

File Attachments Section

The File Attachments section lists any attachments saved in the current document. Click a file to select it, then use the tools in the File Attachments button bar to open, save, or delete it. Double-click a file name to open it.
**File Attachments Button Bar**

1. **Open**: Opens the selected file.
2. **Save**: Saves a copy of the selected file locally, outside of the document it's attached to.
3. **Add New**: Uses an Open dialog to select a file from your computer to attach to the current document.
4. **Delete**: Removes the selected attached file from the document.

**File Properties Section**

The File Properties section displays, and allows editing of, the following metadata fields: Title, Author, Subject, Project, Reviser, and Client.

**File Custom Properties Section**

The Custom Properties section displays, and allows editing of, additional custom metadata.
To add a new field, click an empty cell in the **Name** column, type a name for the property, then click in the corresponding **Value** column cell and add the value. To delete a custom row, click in either cell and click **Delete**.

**Markup Properties Sections**

When a markup is selected, the tab displays all of the parameters that are configurable for that particular markup.

**General Section**

The General section is different for different markups, but will often contain a comment preview window, Author and Subject fields, and a Lock checkbox to avoid accidentally moving or changing the markup.

**Appearance Section**

This section contains settings pertaining to the display style of the markup. See the sections on individual markup tools for what specific appearance settings are available for that tool.
**Layout Section**

This section reports where the markup exists on the document page. Enter values to place markups precisely. If you move a markup by clicking and dragging, the change is reflected here.

![Layout Section](image)

**Options Section**

This section will also vary from markup to markup, but generally holds a quick menu to allow adding the current tool to My Tools or any tool set in your tool chest and a button to make the current settings the default for that tool.

![Options Section](image)

**Exercise 1.3 Viewing Markup Properties**

1. Go to the **Markup Group**
2. **Add a Markup** of your choice
3. Open up **Properties**
4. Click on your PDF
   
   *Notice you are on the properties for your PDF*
5. Click on your Markup
   
   *Notice you are on the properties for that particular markup*
**Thumbnails Tab**

The Thumbnails tab displays small previews of PDF pages for quick navigation within a multi-page document. By default, it appears in the left panel.

To display the Thumbnails tab, click ▼ > Thumbnails or press Alt+T.

**Thumbnails Button Bar**

1. **Reduce Thumbnail Size**: Reduces the size of the thumbnail images.
2. **Increase Thumbnail Size**: Enlarges the thumbnail images.
3. **Show/Hide Page Label**: Toggles page labels on or off underneath the individual thumbnails.
4. **Create Page Label**: The AutoMark™ technology allows automatic Page Label modification based on Bookmarks or a specified Page Region on the PDF that is consistent on each page.

**Bookmarks Tab**

Revu recognizes existing bookmarks in PDFs and enables users to create and edit bookmarks as well. Bookmarks contained in a PDF are displayed in the Bookmarks tab. For more information, see the section on Working with Bookmarks.

When generating PDFs from other file types using the Bluebeam PDF creation tools, certain content will be automatically transformed into bookmarks – for example, a Microsoft® Word table of contents, worksheet labels from Excel® and slide headers in PowerPoint®. When using AutoCAD®, Revit® or SolidWorks®, bookmarks can be created from layout sheets as well.

To display the Bookmarks tab, click ▼ > Bookmarks or press Alt+B.
Left-pointing triangle icons along the right side of the bookmark list indicate bookmarks associated with the current page. A bookmark will not have this symbol if it links to an element on a different page.

**Bookmarks Button Bar**

The Bookmarks button bar contains tools to organize and navigate bookmarks.

1. **Expand All**: Expands the entire bookmarks list.
2. **Collapse All**: Collapses the entire Bookmarks list.
3. **Save Collapse State**: Saves the current Collapse/Expand state as the default (requires that the file be saved as well to retain this default across sessions).
4. **Create Bookmarks**: Makes a new bookmark and allows you to specify the name, viewing scale and page range. With AutoMark™, bookmarks can automatically be created from existing page labels or text found in a specific region on each page of the document.
5. **Add**: Adds a bookmark to the current page, visible below the currently selected bookmark in the bookmarks list.
6. **Delete**: Deletes the selected bookmark(s).
7. **Action**: Opens the Action dialog, which allows the user to insert a hyperlink into a bookmark.
8. **Properties**: Opens the Bookmark Properties dialog.
9. **Audit Bookmarks**: Analyzes the bookmarks list to ensure the links still work
**Search Tab**

The Search tab allows you to search for text in the current PDF, all open PDFs, PDFs in a folder, or in the files in the Recents list. You can perform a **Text search** or a **Visual search**. You can also Search and Replace.

- To display the Search tab, click ➔ Search or press Alt+1 or Ctrl+F.

**Text Search**

Text must be present in the PDF file for text search to find it. Scanned PDF files are images and do not contain any text, so they are not searchable. See Optical Character Recognition (OCR) for details on how to make scanned documents searchable.

**Visual Search**

Visual Search allows for the searching of graphical symbols in PDFs. To set the search criteria, define a rectangle around the symbol or graphic that you want to search for in the document.
Working with Profiles

Profiles provide an easy way to store the toolbar, menus, and other display settings within Revu. Profiles can also be used to shape the User Interface of Revu for particular job functions within your organization. For example, you may create a simplified interface, turning off most of the toolbars within Revu, for those users within your organization who would only be viewing PDFs and not have need to edit PDFs. Additionally, you could turn on only the most basic markup functions without any of the advanced editing functions and save a profile for basic markup users.

The toolbar settings are available from the Profile button menu. The check next to the profile name indicates the currently active profile setting. To switch to a different profile, select another profile from the menu. Once selected, the Revu interface will update based on the settings defined in the new profile.

Exercise 1.4 – Viewing Profiles

1. Select the View group of the Command Bar
2. Click the down arrow next to the Profiles button and select the Simple profile
3. Ensure that the Left & Right Panels are expanded
4. Select the Tool Chest tab from the Left Panel
   
   Take note of which Toolbars, Tool Sets, and Tabs are displayed
5. Click the down arrow next to the Profiles button again, and select a different profile
6. Ensure that the Left & Right Panels are expanded
7. Select the Tool Chest tab from the Left Panel
   
   Take note of how the Toolbars, Tool Sets, and Tabs have changed
Preferences

The Preferences dialog enables customization of Bluebeam Revu settings. This section briefly describes some commonly used settings, organized by the section of the preferences dialog that contains it.

To invoke the Preferences dialog:

- On the Command Bar, click Settings, then click Preferences.

- or-

- Press Ctrl+K.

Some commonly changed preferences will be discussed in this section.
General

**User:** Each time a markup is made, Revu records who made it. This field defines the name to use.

**Enable Document Recovery:** If Revu quits unexpectedly with this option set, the next time Revu is started, it will attempt to recover unsaved changes to the document(s) open in the previous session.

**Allow Multiple Instances:** This enables or disables the Multi-Revu feature.

**Enable Auto-Complete:** Remembers previously entered text. Click the Manage button to edit the auto-complete history.

**Show Splash Screen:** Enables or disables the Revu splash screen when Revu is first launched.

**Use Large Icons:** The User Interface Icons will be displayed larger and support High Resolution Displays.

**Reset Hidden Messages:** Resets the display of the dialog boxes where "Don't Show Again" was selected.

**Tab Truncation:** Determines if the file name in the opened tab, truncates the beginning or end of the name.

**Brightness:** Sets the overall brightness of the Revu interface.

**Classic Mode:** Switches to an emulation of the appearance of the default interface for Revu prior to version 6.

**Classic Menu:** Switches the menus to classic menus.
**Grid & Snap**

**Units Section**

**Application Units**: Defines the system of measurement to use for rulers and measurement dimensions.

**Grid Section**

**Show Grid**: Provides control over displaying the grid. Also controlled by the **Grid** button on the Status Bar.

**Snap to Grid**: Makes any points used to define a markup line up with the defined grid. Also controlled by the **Snap** button on the Status Bar.

**Grid Spacing**: Controls increments between grid units, which affects the snap-to resolution as well as the spacing of the grid markers that are displayed on the PDF. A smaller increment makes a smaller grid, a larger increment makes a larger grid.

**Snap**

**Snap to Content**: Snaps markups to the underlying PDF vector content. A small box appears over the underlying PDF content when markups are being made. The following image demonstrates the behavior as a line markup is being drawn. Snap to Content does not snap to text or images in the PDF, only vector images such as lines and shapes. It is also controlled by the **Content** button on the Status Bar.

**Snap to Markup**: Snaps the cursor to other markups in the PDF. This can also be controlled by the **Markup** button on the Status Bar.

With Snap to Markup enabled, two related behaviors will occur. The cursor will snap to points on other markups, like Snap to Content snaps to points in the PDF content. Revu will also display – and the cursor will snap to – guidelines that are based on lines in nearby markups.
**Snap Color**: Determines the color of the indicator box.

**Sensitivity**: Move the slider to High to make the snap area smaller. Move the slider to Low to make the snap area larger.

**Markup**

**Reuse Markup Tools**: If checked, the last markups used will remain selected so it can be used over and over again. If unchecked, after a markup is placed Revu will switch back to pan mode.

**Dynamically Set as Default properties**: Remembers the last property settings for a markup. For example, if the appearance properties for a rectangle markup were set to a Green color, 2 point wide line, the next time that the rectangle markup is selected, these properties will be used.

**Autosize Text Box and Callout Markups**: Fits the surrounding text box to the entered text for callouts and text markups. After editing the text in a Free Text or Callout markup, the text box will resize automatically to fit the text.

**Embed Fonts**: Includes fonts used for markups in the PDF.
**Show Author and Date in Pop-Ups:** Displays Author and Date in popup notes when a markup is double-clicked. The title and author will also appear when a note markup is added to a PDF.

**Print Pop-Ups:** Check to print Notes and Comments popup boxes.

**Opacity:** Opacity level that Notes and Comments popup boxes will be printed if **Print Pop-Ups** is checked.

**Copy Selected Text into Text Markups:** Any time a text markup is used, the annotated text will be copied to the copy buffer so that it can be pasted into other applications. Text markups are Highlight, Underline, Squiggly line, and Strikethrough.

**Retain Layer Info when copying Markup:** Layer information will be copied when you copy a markup. If you copy a markup to another PDF, its layer will be created in the new PDF.

**Use Relative Paths for Hyperlinks and Actions:** Set the default status for paths to be "relative" when Hyperlinks and Actions are created.

**Set 'Open in New Window' option for Hyperlinks and Actions:** Set the option to open a Hyperlink or Action in a new window when the Hyperlink or Action is created. This option only applies when viewing PDFs in Acrobat or Reader. Revu already opens the links in a new tab.

**Default Image Encoding:** Chooses the format in which embedded images and inserted image markups are stored in the PDF.

**Drag Behavior for Shapes:** Determines whether, when drawing certain shapes (polygons, area measurement), a rectangle is used or whether the drag behavior sets control points for the Bézier curves used to define the shape. The effect will be either a rectangle is dragged, or a curve shape will be drawn.
Chapter 1: Interface

Idaho Transportation Department

**Navigation**

**Mouse Wheel Section**

Set how the mouse wheel behaves in this section.

**Single Page Mode**: Sets the mouse wheel behavior in single page mode. Choose either **Zoom** or **Scroll**.

**Continuous Mode**: Sets the mouse wheel behavior in continuous mode. Choose **Zoom** or **Scroll**. This behavior is independent of the Single Mode setting.

**Reverse Mouse Wheel when Zooming**: Changes the direction for when the mouse wheel will zoom in versus zoom out.

**Sensitivity**: Controls how much the zoom level changes per mouse wheel click.

**Enable Horizontal Mouse Wheel**: Enables panning for mice that have tilt-able scroll wheels.

**Options Section**

**Synchronize Views**: Synchronizes the viewing windows when displaying the PDF in side-by-side Split View mode. The **Mode** can be changed to sync by **Document** or by **Page**. This is useful when you need to compare two different versions of the same document. Moving the document in one window will automatically adjust the view in the other window(s).

**Enable Horizontal Scrollbar**: Toggles on and off the horizontal scroll bar at the bottom of the document tab.

**Show Vertical Scrollbar on Left**: Displays the vertical scrollbar on the left side of the PDF page instead of the right.

**Lock Panning in Fit Width**: Constrains panning to vertical movement when in **Fit Width** mode. This prevents the page from sliding sideways if the mouse is moved slightly horizontally.

**Maximum Zoom**: Sets the maximum percentage the workspace will allow zooming of PDFs.

**Enable 3D Mouse**: Enable 3D navigation with a 3D mouse.
**Studio**

**Account**

Change your account settings, create an account or login to Studio.

Checkout on Open: If this option is selected, when a Studio Project file is opened, it is automatically checked out.

**General**

Enable Sounds: Play sounds with studio events.

Enable Flashing Alerts: Turn off visible flashes with studio events.

**Exercise 1.5 – View Preferences**

1. Click the drop-down menu next to the **Settings** button and select **Preferences**

2. Navigate to the **General** section in the list on the left-hand side of the **Preferences** dialog
3. View Preferences
4. Click the **OK** button to close the dialog
Chapter 2:
Commenting & Markups
This chapter delves into the following topics:

✓ **Markup Tools**
  Location and Types of Markup Tools

✓ **Measurement Tools**
  Calibrating a PDF
  Creating and Modifying Viewports
  Location and Types of Measurement Tools

✓ **The Tool Chest**
  Using Tool Sets
  Tool Modes

✓ **Working with Stamps**
  Placing Stamps
  Applying Stamps to multiple pages
  Flattening Stamps

✓ **Markups List**
  Markups List Tool Descriptions
  Using the Markups List
Chapter 2: Commenting & Markups

Compatibility

Comments made in either Acrobat or Revu can be seen in both without any issue. If you add comments to a PDF from within Adobe, you can open the PDF and see those comments even in Revu.

Markup Overview

The tools to create and edit markups can be found in the Markup and Measure groups of the Command Bar, in the Text and Shapes toolbars, and in the Tool Chest tab. In addition, most markup tools have convenient keyboard shortcuts. Each time a markup tool is selected and used, the markup is stored in the Recent Tools section of the Tool Chest tab.

Markup Tools

The Markup group contains menus and commands to allow the markup of PDFs.
Text Menu

The Text menu contains tools to create text-bearing markups.

- **Text Box (T):** Adds a text markup.
- **Callout (Q):** Adds a text callout.
- **Typewriter (W):** Enables freely typing text on a PDF.
- **Note (N):** Adds a sticky note. Caution: If any popup text windows are closed, the popup text of those markups will not show up when printing.
- **Flag (F):** Adds a linked flag on the currently active page.

Pen Menu

The Pen menu contains markup tools that behave in a similar manner to a real-world pen.

- **Pen (P):** Adds a free-drawn markup.
- **Highlight (H):** Adds a semi-transparent line simulating a highlighter.
- **Eraser (Shift+E):** Removes pen and highlighter markups.
**Lines Menu**

The Lines menu contains tools to create linear markups.

- **Line (L):** Adds a line. Hold *Shift* to snap line in 45° increments.
- **Arrow (A):** Adds an arrow markup.
- **Arc (Shift+C):** Adds an arc markup.
- **Polyline (Shift+N):** Adds a segmented line.
- **Dimension (Shift+L):** Adds a dimension or leader line markup on the PDF.

**Shapes Menu**

The Shapes menu contains tools to create outlined shape markups.

- **Rectangle (R):** Adds a rectangular markup.
- **Ellipse (E):** Adds an elliptical markup. Hold *Shift* to make a circle.
**Polygon (Shift+P)**: Adds a polygon markup with no defined angle. Click to set each point, then press **Enter** or double-click to finish.

**Cloud (C)**: Adds a polygon with a cloud-like appearance preset.

**Cloud+ (K)**: Adds a polygon markup with a cloud-like appearance and callout box preset.

**Sketch**

Sketch Tools quickly creates Polygon, Polyline, Rectangle and Ellipse markups based on a PDF’s calibrated scale. A convenient display provides real-time length and angle feedback as you sketch details with your mouse, or enter precise dimensions with your keyboard.

**Polygon Sketch to Scale**: Adds a polygon markup to an exact scale.

**Rectangle Sketch to Scale**: Adds a rectangle markup to an exact scale

**Ellipse Sketch to Scale**: Adds an ellipse markup to an exact scale

**Polyline Sketch to Scale**: Adds a polyline markup to an exact scale.
Image and Image Menu

Image (I): Inserts an image from a graphic file accessible on your workstation. Click to the right to access the Image Menu.

Image from Scanner (Shift+I): Displays the Scanner dialog to acquire images from a scanner or camera. Images captured result in new image markups.

Crop Image: Crops an image markup. Click and drag to define a rectangle. Areas of the image markup outside the rectangle will be eliminated.

Camera

Camera: Adds an Image markup using the camera in the laptop or tablet.

Hyperlink and Hyperlink Menu

Hyperlink: Allows the creation of hyperlinks in a PDF. Click to the right to access the Hyperlink Menu.

Create Hyperlinks from URLs: Creates hyperlinks from URLs that exist in the PDF content.

Attachment

Attachment: Opens the Add Attachment dialog to allow embedding a file in the PDF.
Chapter 2: Comments and Markups

**Stamp Menu**

The Stamp Menu can be used to add "rubber stamp" comments on the drawing.

This tool is what you will use to work with the out-of-the-box stamps or any stamps that you create yourself. Any standardized stamps will be accessed via your section specific stamp Tool Sets. For more information see the **Working with Stamps** section below.

![Stamp Menu Image]

**Exercise 2.1 – Practice with Markup Tools**

1. Click the **Open** button

![Open Button Image]

2. Navigate to the ITD Bluebeam Training folder ([link](#)) on ITD Sharepoint

3. Open the **BB Revu Example.pdf** file

4. Experiment placing various markups on the PDF including a **Callout** markup, **Text Box** markup, **Arrow** Markup, & multiple **Cloud** markups
Measurement Setup

The Measurements tab provides access to the measurement modes, allows setting the document scale, setting up Viewports for multiple scales in the same document, and other measurement options.

To display the Measurements tab, click > Measurements or press Alt+U.

Calibrating a PDF

The Calibrate button brings up the Calibrate dialog to allow accurate measurements to be taken from a PDF. First, locate a labeled, known length somewhere on the PDF.

- On the Command Bar, click Measure, then click Calibrate.
- or-
  - On the Measure toolbar, click Calibrate.
- or-
  - In the Scale section of the Measurements tab, click Calibrate.

  - Click OK.
  - Click the first point of the known length, then click a second point to finish the line. You can hold down the Shift key to snap the two points horizontally.
  - Enter the distance that these two points represent on the drawing and click OK.

NOTE: If you are working with a vector-based drawing (as opposed to a scanned PDF), you can enable Snap to Content which makes the cursor snap to the underlying lines and drawing elements, making it much easier to accurately select the two points.
Alternatively, if you already know the scale, enter the values in the Scale section of the Measurements tab. It is recommended to always use Calibrate if possible, as sometimes scaling occurs during the PDF creation process.

The unit drop down list determines the units in which the measurements will be reported. In the preceding example, the result will be displayed in “feet-inches.”

**Precision** determines the decimal or fractional precision of the measure value displayed.

**Working with Viewports**

Different scale zones can be defined within a drawing or document by clicking the **Add** button in the **Viewports** section of the **Measure** tab. To define the region on the page, click and drag a rectangle around the area the scale should apply to, and then type the viewport **Name**. Once the area is defined on the PDF, click the **Calibrate** button and select two points within the viewport to define the scale.
When the viewport name is selected in the list, the viewport area, name and scale will display in the drawing.

Note: When a measurement is placed on a PDF with Viewports defined, the Viewports are highlighted with their associated scales displayed. If you notice a viewport that is untitled, this could be affecting the accuracy of your measurements in that area. In this case, the untitled viewport should be deleted.
**Measurement Tools**

The Measure group contains the Measure and Calibrate tools plus quick access to the various measurement modes.

---

**Measure Tool**

**Measure** (M): Creates a temporary measurement or markup in any of eight measurement modes.

**Calibrate**

**Calibrate**: Calibrates the scale to allow accurate measurements to be taken.

**Linear Menu**

The Linear menu contains linear measurement modes.

---

- **Length**: Calculates a linear measurement.

- **Perimeter**: Calculates the length of all the sides of a given shape or multi-segment line.

**Area**

**Area**: Calculates the area of a simple rectangle or of an irregular, polygonal shape.

**Volume**

**Volume**: Calculates the volume of an area with a defined depth.
Cutout

Cutout: Allows you to cut out or subtract an area from an existing Area or Volume measurement.

Count

Count: Places a markup for each mouse click, associating a running total of counts with each markup as it is placed.

Geometric Menu

The geometric menu contains measurement modes that calculate angles and circular features.

- **Diameter**: Calculates the diameter of a circular shape.
- **Angle**: Measures a given angle as defined by three points.
- **Radius**: Measures the radius of an incomplete circle defined by three points along the arc.
Exercise 2.2 – Calibrate the Measure tool

(NOTE: if you already know the PDF's scale, you can enter it in the Scale section)

1. Open **BB Revu Example.pdf** (if not already open)
2. Click the Tab Access menu on the left side of the Command Bar and select the Measurements tab
3. Collapse the Scale section

4. Expand the Viewports section of the Measurements tab.
5. Click-and-drag a rectangle over the desired measurement area.
6. Name the Viewport **BB Revu Example**, then click **OK**
7. Click the Calibrate button in the Viewports section of the Measurements tab

8. Click **OK** on the dialog that follows
9. Click the first point of the known length, then click the second point to finish the line. Hold down SHIFT to snap the two points horizontally, vertically, or diagonally (as appropriate). When the second point is selected, the Calibration dialog box opens.
   
   You can zoom in and out with the mouse wheel for better snap accuracy
10. Change the units drop-down menu to the desired measurements, then click **OK**
11. To store this calibration on the current page, select **Store Scale in Page**. To apply this calibration to all pages in the document, select **Apply scale to all pages**. Any existing scales on affected pages will be overwritten.
12. Use the **Length** tool at the top of the Measurements tab to place some additional measurements
The Tool Chest

The Tool Chest is a powerful feature that makes the marking up of documents much more efficient. Once a markup is created, it can be easily recalled using the Tool Chest. The Tool Chest will store your most used markups in a central, easily accessible location.

By default the Tool Chest is in the left panel. To access the Tool Chest, click Tool Chest or by pressing Alt+X.

Using Tool Sets

Click any tool in the Tool Chest to select it, then click on the document to place the markup.

To copy a tool from one tool set to another tool set:

- Click and drag the icon to the desired tool set.

To reorder the tools within a set:

- Click and drag the icon to the desired location.
To delete a saved tool:

- Click a tool to select it, then click the Delete Icon on the Tool Chest button bar.
- or-
- Click a tool icon to select it, then press the Delete key.
- or-
- Right-click a tool icon, then click Delete.

To duplicate a tool:

- Right-click a tool icon, then click Duplicate.

To change the colors of a tool:

- Right-click a tool icon, then click Change Colors.

**Reusing Recent Tools**

The Recent Tools section records every markup as it is added to the PDF.

To reuse a tool, simply click the icon and then click on the PDF to place the markup.

The Recent Tools history is temporary; it only lasts until Bluebeam Revu is closed.

**Permanently Saving a Tool to be Reused**

To save a recently used tool so it will remain after the program has been closed, click and drag the tool's icon from Recent Tools into My Tools or another tool set, or right-click the icon and then click Add Item to My Tools.

To save a markup on the document as a reusable tool, right-click the markup, hover over Add to Tool Chest, then click the tool set to save it to (For example, My Tools).
Managing Recent Tools

If too many tools have been used recently to view them all in the Recent Tools section, an arrow appears to the right of the row. Click the arrow to access all recent tools.

To set how many recent tools to retain:

- Click the gear at the top right of the section, then hover over **Maximum Recents**.
- In the **Maximum Recents** submenu, click a value to set the number of recents.

Clearing Recents and Hiding the Recent Tools Section

To clear all recent tools without closing Revu:

- Click the gear at the top right of the section.
- Click **Clear Recents**.

To Hide the Recent Tools Section:

- Click the gear at the top right of the section, then click **Hide**.

Click the **Manage Tool Sets** menu in the Tool Chest button bar, then click Recent Tools, to show it again.
Properties Mode vs. Drawing Mode

Items in My Tools, Recent Tools and custom tool sets can function in two different modes. The tool icon changes to show which mode is currently being used.

![Double-click]

← Double-click →

Drawing Mode  Properties Mode

**Properties mode** adds a new markup with the same display properties of the saved markup. In this mode the Properties (as displayed in the Properties tab) are retained but the exact dimensions, text, and so on are not. In the preceding example, using the tool in Properties mode would create a new yellow text box with black border and text color, but no text would be inside the box yet, nor would the box have a fixed size.

**Drawing mode** adds a new markup that is an exact duplicate of the saved markup, as if you'd copied and pasted the original markup rather than made a new one of a similar type.

To change the mode, double-click on the icon. All information of the original markup is always retained when switching modes. Only the icon and the way that the markup is added to the file change when the mode is switched. By default, most tools are saved in Properties mode. There are some markups that always remain in Drawing mode. A Stamp and a Grouped markup are two examples.

To set all markups to default to Drawing mode:

- Click the gear at the top right of the section, then uncheck Properties Mode.

**Sequences & Actions**

A **Sequence** allows a text based markup to increment in value each time that a markup is added to the PDF. The updating sequence value can be a number or text. An **Action** allows you to add hyperlinks to tools in the Tool Chest.
Exercise 2.3 – Adjusting Preferences

1. Place a small Rectangle markup, and set the Style property to Cloud.
   
   Hint: Expand the Right Panel to expose the Properties tab

2. Expand the Left Panel and select the Tool Chest tab

3. Select the Rectangle markup, right-click and select Add to Tool Chest -> My Tools
   
   (You may also use the Add to My Tools button found under the Options menu of Rectangle Properties preferences.)

   Note how the Rectangle markup is added to the My Tools tool set in Drawing Mode
4. Find the **Rectangle** markup in the **Recent Tools** tool set, right-click and select **Add Item to My Tools**

![Add Item to My Tools](image)

*Note how the **Rectangle** markup is added to the **My Tools** tool set in **Properties** Mode*

5. Place additional **Rectangle** markups using the two newly created tools in the **My Tools** tool set

*Observe the difference between those placed with **Drawing** mode, and those placed with **Properties** mode*

---

**Pinning a Tool Set**

- For quick and easy access, a Tool Set can be pinned to any Toolbar.
- Click the small **gear** to the right of the Tool Set name.
- Click **Pin to Toolbar**, then select the specific Toolbar.
Bluebeam Revu  Idaho Transportation Department

**Markups List**

The **Markups** list is a specialized tab with a horizontal layout that provides powerful features for processing, accessing, reviewing, and summarizing the markups on a PDF. By default it is found in the bottom panel.

To access the Markups list, click > Markups or press Alt+L.

**Markups List Button Bar**

The Markups list button bar contains tools for organizing, processing, importing and exporting data.

- **Expand All**: Expands the entire Markups list.
- **Collapse All**: Collapses the entire Markups list.
- **Previous**: Moves to the previous Markups in the list.
- **Next**: Moves to the next Markups in the list.
- **Filter**: Displays only markups that match the filter criteria.
- **Clear Filters**: Clears applied Filters.
- **Hide Markups**: Hides all markups in the current PDF file. Markups will not display or print when this mode is enabled. This mode is temporary and will be reset the next time that Revu is started.
- **Search box**: Filters based on the text entered in the box.
- **Columns menu**: Selects which columns to display in the Markups list.
- **Manage Columns**: Launches the Manage Columns dialog to change the display order and add, remove, and create custom columns. Columns can also be reordered by dragging and dropping column headers.
Delete: Deletes currently selected markup or reply.

NOTE: Delete removes the markup from the PDF, not just from the list.

Reply: Replies to the selected markup. Replies appear on a new indented row below the markup in question.

Status menu: Sets the status of the markups. The default states are the following: Accepted, Reject, Completed, Canceled, None.

Manage Status: Creates and manages custom states.

Checkmark menu: Checks or unchecks the checkbox associated with the selected markup. Also provides a command to clear all checkboxes.

Import: Takes the markups from a PDF or an XML file and includes them in the active PDF. This is useful for incorporating and reviewing markups or feedback from multiple sources. FDF files containing markups generated from other PDF applications may also be imported.

Export: Exports all markups to an XML file. The XML file can be imported into another PDF so that the markups will be displayed in the target PDF. The created XML file can also be imported into Microsoft Excel for viewing in a tabular form. Markups may also be exported to the FDF format for interoperability with other PDF applications.

Summary: Provides a formatted list of all of the markups in the document. It is also possible to define a subset of markups to summarize.

**Markups List**

The Markups list displays a table, with each row representing a markup that has been added to the active PDF. Each column displays information about the markups.

As a row is selected, the view of the PDF in the workspace will jump to the location of the associated markup. This makes it easy to use the markup list to step through the markups in PDF. To step through, click the Previous or Next buttons, or press the Up/Down arrow keys.

Horizontal section separators with disclosure triangles show and hide each section of the Markups list. Click a disclosure triangle to show or hide that section.
The following figures show an expanded, collapsed and partially collapsed list that is sorted by Page number:

**Expanded List**

![Expanded List Image]

**Collapsed List**

![Collapsed List Image]

**Partially Collapsed List**

![Partially Collapsed List Image]
Columns Menu

The Columns menu allows you to toggle on and off various columns. A column that is turned on will appear in the top row of the Markups list and will display a check box next to the name in the menu. Click a column name to turn it on or off. To sort by any column, click the column's name on the header. Click again to reverse the sort order.

Subject: Displays an icon of the markup and text referring to the subject of the markup. By default, the text contains the name of the tool used to create the markup (Pen, Highlight, Callout, etc.). This text can be changed in the Subject field in the Properties tab, or by double-clicking on the Subject text in the Markups list.

Page: Displays the name of the page on the PDF on which the markup is located.

Page Index: Displays a numeric value indicating the page on which the markup or measurement resides. The Page Index is a useful column for sorting when exporting to spreadsheet programs.

Lock: Toggles whether the markup is locked for editing or not. If locked, a padlock appears in the box, and the markup cannot be moved or changed. If unlocked, the box is clear and the markup can be edited.

Status: Can be set to one of the default states or a custom status. The default values are Accepted, Rejected, Canceled, Completed and None. Once the status is set on a markup, you can sort by status.

Checkmark: Toggles the checkbox, enabling the Markups list to be used as a basic checklist. As changes are being reviewed, click to check the box; click again to uncheck it.

Author: Indicates the username of who made the markup. Double-click this field to edit your displayed name. To set the name globally, click Settings > Preferences > General, then enter a name in the User box.

Date: Displays the date and time the markup was modified based on the system time.

Creation Date: Displays the date and time the markup was created based on the system time.
**Color:** Displays the fill color that was used for the markup. You may sort by this column to group all "red" or "blue" markups.

**X** and **Y:** Display the coordinates on the PDF page where the markup is located, counted from the lower left.

**Width** and **Height:** Display the size of the markup itself.

**Comments:** Displays the comments from the General section of the Properties tab for this markup. Double click in this field to change the comment associated with the markup.

**Length, Area, Volume, Count,** and **Measurement:** All display values associated with Measurement markups.

**Label:** Displays the label associated with the markup. Label can be changed in the General section of the Properties tab. For measurement markups, it is common to use the Label field to specify the type of material that's being measured, such as "Asphalt Pavement 1" or "Conduit 3".

**Sequence:** Records the numerical value associated with a Sequence markup.

**Layer:** Displays the Layer the markup is associated with.

**Space:** Displays the Space that contains the markup.

**3D View:** Displays the 3D view that contains the markup. Click to jump to that view in the 3D window.

**Context Menu**

Right-click on any field in the markup list to display a context menu for performing functions on the currently selected cell. The first option, **Copy**, stores the contents of the cell on the clipboard, enabling the pasting of the information within Revu or other Windows applications.
Exercise 2.4 – Viewing

1. Using the **Tab Access Panel**, open the **Markups** tab

![Tab Access Panel](image)

2. Click on the **Subject** column header

   *To sort your comments by type*

3. Right-click one of your **Text Box** comments

4. Select **Reply**, then type a response

5. Select all of your **Cloud** markups

   *In the bottom panel on the **Markups** tab, click on the first **Cloud** markup, hold the **Shift** key and click on the last **Cloud** markup*

6. **Right click** the selected markups and select **Set Status**, then choose **Accepted**

7. On the top of the **Markups** tab, click the **Filter** button to turn on filtering

   *Notice this greys out filtered comments*
8. Click on the drop-down menu next to the **Status** column header and select **None** (click the blank box).

   *The Cloud comments are now shown in grayscale on your pdf*

9. Click on the **Filter** button once more to turn off filtering

10. Check-in and close the **BB Revu Example.pdf**
Chapter 3:
Document Manipulation
This chapter delves into the following topics:

✔ Document Manipulation
   - Insert
   - Extract
   - Rotate
   - Crop

✔ Document Comparison

✔ Stapler
   - Combining
   - Converting
Chapter 3: Document Manipulation

The Document group provides commands and menus for working with the PDFs. The Pages menu contains commands for manipulating the actual pages of the PDF.

1. Insert Pages – adds a blank page
2. Extract Pages – removes or copies one or more pages from the document to a new pdf
3. Rotate Pages – Rotates one or more pages in 90-degree increments
4. Crop Pages – reduces the page size according to user definition

Insert

To insert a blank page or a new page from a saved template, use the Insert Blank Page command
**Extract**

Individual pages or a range of pages can be pulled out of the current document into a separate file or group of files using the **Extract Pages** command.

**Rotate**

To rotate the currently active page by 90°, use the Rotation toolbar. If you do not see the Rotation toolbar, click **View > Toolbars > Rotation**.

**Crop**

Bluebeam Revu includes a cropping tool that allows you to remove unwanted parts of a PDF page. Using the Crop Pages feature will modify the PDF file; therefore it is recommended that you make a copy of the PDF before proceeding.
Document Comparison

The Compare Documents feature is used to compare two PDF files and highlight the differences. The differences are indicated with markups. Once the markups have been created, the differences can be reviewed using the Markups list.

Comparing Two Versions of the Same Document or Drawing

- On the Command Bar, click Document > Comparison > Compare Documents...

Defining Documents A and B

- If the document is already loaded within the current Revu session, click the Document list in the Document A section, then click the name of the file.

- If the document is not loaded, click .

- In the Open dialog, locate the appropriate file, then click Open.

- Click the Page Range list to define a range of pages to use for comparison.

Follow the same steps in the Document B section to define Document B.

Optionally Defining a Region

If you want to compare only a specific region of each document, click Select Window, then define a rectangle. Otherwise the entire document will be compared.

Aligning the Documents

By default Revu will attempt to line up the document. If you wish to override the automatic alignment, click Pick Points to specify the alignment points. You will need to pick 4 points on each document. The points should be specified in a clockwise order and the alignment points should correspond to one another; for example, Selection Point 1 on Document A should correspond to Selection Point 1 on Document B.
Defining the Appearance of Markups

Click Advanced to change the markup appearance. Options include Color, Fill, Opacity, whether the markup has a cloud appearance, and if the markup should be locked when placed in the PDF.

The Subject field can be used to name the difference markups (e.g., “Differences 2-6-09”). You can then sort the Markups list based on Subject. All difference markups will be grouped together since each markup has the same subject. A series of difference comparisons can be made over time to provide a change history.

The Apply to list determines to which document the markups are added when the comparison is run. The settings available are the New Copy of Document A, New Copy of Document B, Both Document A and B, Document A Only, Document B Only.

Choosing Other Options

Check the Split-screen view box to open side-by-side synchronized windows for reviewing the differences noted after the comparison process completes. Check Turn on Dimmer to dim underlying PDF content and make the locations where differences are found easier to see.

- To run the comparison, click OK.

Once the comparison completes, any differences will be annotated.

If the Split-screen view box was checked, the two compared documents will open in a side-by-side manner. Zooming or panning on one window will update the display in the opposite window. This is useful for visually comparing the before/after, changed, and unchanged parts of the two documents. The markups that were added will appear in either the left or right window depending on which PDF was specified.

Open the Markups list to see a table of markups that were automatically added when differences were detected.

As a markup is selected in the Markups list, the Revu workspace will jump to the location of the difference.
Exercise 3.1 – Compare Documents

1. Select the Document group on the Command Bar
2. Click on the drop-down menu next to the Comparison button and select Compare Documents…
3. Under the Document A section, click the button
4. Navigate to the Bluebeam Training folder
5. Open the BB Revu Example.pdf file
6. Repeat steps 3-6 for the Document B section, using the BB Revu Example 2.pdf
7. Click the OK button to compare the documents

Take note that the differences are surrounded by filled cloud markups
8. Click on the drop-down menu next to the Comparison button and select Overlay Pages
9. Click OK to the Overlay Pages dialog box

If prompted, answer NO to the following box
Layers tab will allow you to turn Layers on and off and can be turned on after opening in comparison mode

10. Add Layers Tab
11. Turn Layers on and off
12. Close the New file, do not save changes
Deskewing

The deskewing feature is used to straighten a document that is not aligned properly. As you can see below the plan sheet tilts upwards. To fix this we will use the deskewing feature.
**Deskew Using Page Setup**

1. Go to **Document > Page Setup**. The **Crop and Page Setup** dialog box appears.
2. On the Page Setup tab, click Get Line.

![Page Setup dialog box](image)

3. Click two points on a line that should be horizontal in the PDF.
4. The **Page Setup** dialog box will reappear with a preview of the adjusted PDF. Click **OK** to complete the align/de-skew operation.

The **Page Setup** dialog box will disappear to reveal the document and the cursor will change to a crosshair.
**Deskew Using the Keyboard**

1. Press **CRTL+ALT+D**. Your cursor will change to a crosshair.
2. Click two points on a line that should be horizontal in the PDF.
3. The **Page Setup** dialog box will reappear with a preview of the adjusted PDF. Click **OK** to complete the align/de-skew operation.

**The Deskew Toolbar Button**

1. Click **Deskew**. Your cursor will change to a crosshair.
   - By default this button is not in any toolbars. To learn how to add it to a toolbar, see Customizing Toolbars.
2. Click two points on a line that should be horizontal in the PDF.
3. The **Page Setup** dialog box will reappear with a preview of the adjusted PDF. Click **OK** to complete the align/de-skew operation.
Chapter 4:

Studio Session
This chapter delves into the following topics:

- **Studio Session: Create, Share and collaborate in the cloud**
  - **Host a Studio Session**
    - Start a Session
    - Manage a Session
    - Attendee Access
    - Add Attendees to a Session (Invite Attendee)
    - Allow or Deny an Attendee
    - Manage Documents

- **Create a Report**
- **Finish a Session**
Chapter 4: Studio Session

Studio Session: Create, share and collaborate in the cloud

Studio combines the best of cloud storage and collaboration. Simply upload your PDFs to a Studio session, and invite attendees from around the world to view and add markups to the same PDFs in real-time or on their own time. All session activity is tracked in a record that conveniently links back to the PDFs. You can even create reports to archive or share with your team.

Host a Studio Session

The session host is the person who starts and controls the Studio Session. The host starts the session, adds the documents, sets session expiration dates, defines the security and permissions then invites the attendees. The host also manages the Session. Documents can be added or removed and new attendees invited. When everyone has contributed, the host also creates the report, finishes the session and saves the files.

However, the host does not need to be in the session for other people to join the session and work. People work at different times and have different times available to them for different types of work. Once a session is started, anyone who has been invited can login to the session and work.

The features available to attendees when attending a session have already been described. This section addresses the features that are unique to the Host.
**Start a Session (Outside of ProjectWise)**

To start a new project:

- In the Studio tab button bar, click **Start > New Session**.

- The **Create Studio Account** dialog displays if you have not already created an account. If you have an existing account you can log in with your existing account.

- The **Start Studio Session** dialog displays.

- Type a **Session Name**.

- Click **Add** to select PDF documents that you want to be part of the session, or click **Add Open Files** to add the files that are already open.

- Select the **Permissions**. You can allow or disallow attendees to Save, Print or Markup the PDF documents that are in the session and Version 2 sessions include the ability to Add Documents to the session.

- Check **Restrict Attendees by E-mail Address** if you want to restrict access to the session by e-mail address. Leave this unchecked if you want to allow users to join the session with only the Session ID.

- Check **E-mail Notifications** if you want to send e-mail notifications to the Host.

- Check **Session Expires** if you want to set an expiration date for the session. Expiration dates must be in the future; Revu will not allow a back-dated expiration date. Additionally, expiration dates can be disabled or changed as
needed throughout the session.

- Click **OK** to save the settings and upload the files. The **Session Invitation** dialog displays.

- The **Session Information** is listed at the top of the dialog. Click the **Copy Invitation** button to copy the session Invitation information to paste it into another program, such as an e-mail message, IM or document.

- The **Invitees** section allows you to add e-mail addresses so you can send the information needed to join the session. This list of e-mail addresses also defines who is allowed to access the session if **Restrict Attendees by E-mail Address** was selected.

  - Click **+** to add a new email address.
  
  - Type the **E-mail** address and click **OK**.
  
  - Select an email and click **** to change an email address.
  
  - Click **X** to remove an email from the list.
  
  - Click **** to add all members of an existing Group.
  
  - Type a **Message**.
  
  - Click **OK** when you are done and the email invitations will be sent from the Studio server.

- **Address Book** will open the address book of your e-mail program so you can select people directly from your existing e-mail contacts.

- **E-mail Templates** allows you create or access templates defined in Revu.

- Type an additional **Message** if you would like to add it to the invitation that is sent.

- Click **OK** when you have finished adding the people and the Studio server will send the e-mail messages.

  **Note**: The e-mail messages are sent from the Studio server (you may need to check Junk Email Folder)
Chapter 4: Studio Session

**Start a Session (Inside ProjectWise)**

To start a new Session:

- In ProjectWise Right click the file you would like to start a Session on.
- Select **Start Studio Session**

The Studio Session will start with your document open and Checked Out in ProjectWise. From this point you can continue with the Login, Setting Permissions for the session and Attendees.

**Exercise 4.1 – Begin a Session**

1. Click on the **Studio** tab in the Right Panel
2. Click on the drop-down menu next to the **Start** button and select **New Session**

3. Click the **Agree** button on the **Welcome to Bluebeam Studio** dialog
4. Click the **Login with Existing Account** link in the bottom-left of the **Create Studio Account** dialog
5. Type your name in the **Session Name** field, then click the **Add** button
6. Navigate to the **Bluebeam Training** folder
7. Open the **BB Revu Example.pdf** file
8. Click **OK** on the **Start Studio Session** dialog
9. Click the **button and type in an **Attendee** email address, then click **OK**
10. Click **OK** on the **Session Invitation** dialog
11. Click **OK** to the box indicating emails have been sent
**Manage a Session**

Documents, Attendees and Permissions can be added or removed during a session.

**Attendee Access**

Changes to the Attendees can be made during a session. Invitations can be sent to new Attendees. New Attendees can be granted access or Attendees can be denied access.

**Add Attendees to a Session (Invite Attendee)**

- Click **Invite** at the top of the Attendees section.
- The Session Invitation dialog displays.

**Allow or Deny an Attendee**

There are three ways to deny an Attendee access to the session:

- Right-click on the name in the Attendees list and click **Deny**.
  - **or** -

- Click **Attendee Access** in the Attendees list. The Attendee Access dialog will display.
- Select the name in the list and click **Deny**.
  - **or** -

- Click **Session Settings**, then click the **Attendees** tab.
- Select the name in the list and click **Deny**.
An Attendee can be allowed back into the session after they have been denied access. Follow any of the steps above and click Allow.

Restrict Attendees by E-mail Address allows access to only those who appear in the Attendees list in the Attendees tab or Attendee Access dialog.

- Click Attendee Access in the Attendees list. The Attendee Access dialog will display.

- Check Restrict Attendees by E-mail Address and click OK.
  - or -

- Click Session Settings, then click the Attendees tab.

- Check Restrict Attendees by E-mail Address and click OK.
Manage Documents

Documents are added when a session is started, but the Host can also add, delete and replace documents during the session.

See the Start a Session topic to add the documents when you start the session.

Add a File:

- Click + Add File in the Documents list.
- Select the file or files and click Open.

Delete a File:

- Right-click on the name in the Document section and then click Delete.
  - or -
- Click X Delete at the right of the document name to delete it.

Replace A File:

- Right-click on a name in the Document section and then click Replace.
  Note: All markups added during the session will be lost if a document is replaced.

Limitations of Bluebeam during a Studio Session

During the Session not all of the Revu tools are available for use. Some of the limitations that we have noticed are as follows:

- No Document Comparison
- No Bookmark Manipulation
- No Add Pages
- No Flags

Exercise 4.2 – Change Permissions

1. In the Studio tab select Session Settings
2. Click the Permissions tab in the Session Settings dialog
3. In the Applied Permissions section, change the Markup permission to Deny
4. Click the OK button to apply the permissions to the session
Create a Report

When the session is complete, a report of the session can be generated and saved to your computer so you have a permanent record of the session.

- Click \( \text{Report} \) in the Record section of the Studio tab. The Session Report dialog displays.

- Click the Type of report that you would like to create.
  
  o **Record Summary** creates a PDF file containing the contents of the Record section of the Studio tab.

  o **PDF Package Report** creates a PDF package containing the Record Summary and all of the documents in the session.

  o **Combine Files Report** creates a single PDF that contains the Record Summary and all of the documents in the session.

Notes:

The PDF Package Report and Combine Files Report contain hyperlinks in the Record Summary that link to the corresponding markup in the document – just like you are still within the session. This lets you review the Record and then jump to the markup in the document.

Options:

- Type the Title of the PDF file or package that will be created.

- Notes will be included at the top of the Report Summary.
  
  o Select the Page Size and orientation.

  o **Include Attendees List** will include a list of the Attendees in the Report Summary.
- Include Documents List will include a list of the Documents in the Report Summary.

- Include Filtered Record items will include all Records in the Summary, even if they are not currently displayed because they have been filtered.

- Fill the check boxes for the columns to include the Date, Time, Document and Page in the Records in the Report.

- Select the Page Size and orientation.

- Include Attendees List will include a list of the Attendees in the Report Summary.

- Include Documents List will include a list of the Documents in the Report Summary.

- Include Filtered Record items will include all Records in the Summary, even if they are not currently displayed because they have been filtered.

- Fill the check boxes for the columns to include the Date, Time, Document and Page in the Records in the Report.

- Click OK to create the Report.
Chapter 4: Studio Session

Finish a Session

Finish the Session ends the session and removes the documents from the Studio server. The Finish Session dialog lets you create the Session Report and select how you want to save or discard the documents.

- Click Finish in the Studio button bar and the Finish Session dialog displays.
- Include Markups allows you to select the Attendees whose markups you want to be included in the documents that you save to your computer. Fill the check boxes next to the Attendees whose markups you wish to save.
- Save Options:
  - Save (Overwrite Existing) will save the files and overwrite the files that you originally selected to upload to the session.
  - Save In Folder allows you to select a new folder where the files will be saved.
  - Check the Session Subfolder checkbox to create a subfolder with the session name.
  - Click Do not save files if you do not want to save copies of the files in the session.
  - Check the Close files after finishing checkbox if you want to close any files from the session that are currently open in Revu. Clear the check box if you want the saved file to open in Revu.
  - Click Report to generate a Session Report.
  - Click OK to Finish the Session.

Note: The Session and all of its files are removed from the Studio server when the session is finished. To gain access to a session that you have already completed, go to https://studio.bluebeam.com
Exercise 4.3 – Finish a session

1. In the Studio tab select the Finish Session button
   
   *Host is the only one who can finish a session, participants can leave a session*

2. Click the Report button
   
   *Note the options*

3. Create a report of attendees and save in the class folder

4. Click the OK button to finish the session

5. Check-in and close the BB Revu Example.pdf

Exercise 4.4 – Reopening a finished session

1. Go to File Group

2. Click on WebTab

3. Click on Favorites or Home drop down

4. Click on Bluebeam Studio Account Administrator

5. Login

6. Click on a Session

   *Note the Status Option*
Appendix
Register / Unregister

Register: Opens a dialog where you may enter your serial number and product key to register your software. This changes to Unregister after Bluebeam has been registered.

To provide more flexibility in the use of Revu, some sections may have you Unregister your copy of Revu when not in active use. You will see the following dialog when registering the product again.
**Default PDF Associations**

In a mixed environment (using both Adobe Acrobat & Bluebeam Revu), a choice has to be made as to which PDF reader is set as the default PDF reader. In most cases this is generally just a user preference, but in a mixed environment leaving Adobe Acrobat as the default PDF reader is recommended. This is recommended because Acrobat Shared Review invitations use the default PDF reader to open links to the Shared Review, while Bluebeam Studio Session invitations know to use Bluebeam Revu regardless of whether or not it is the default PDF reader. In this scenario a user could navigate both invitations without running into any problems.

In the case that you are NOT in a mixed environment, shown below are instructions for setting Bluebeam Revu as your default PDF reader in both ProjectWise and Windows.

**Setting the default PDF reader in ProjectWise**

From within ProjectWise, right-click on a PDF file and choose *Open With…*
In the **Open document with** dialog box, click the **Browse** button, select **Bluebeam Revu** from the list, and then click **OK**.
After you have added **Bluebeam Revu** to the list, make sure the **Always use this program** checkbox is checked, and click **OK** to set a user specific association of PDF files within ProjectWise to Bluebeam Revu.

**Setting the default PDF reader in Windows**

From within **Bluebeam Revu**, click the drop-down menu next to the **Settings** button on the **Command Bar**, then click on **Administrator**.
On the **Bluebeam Administrator** dialog, select the **Revu** tab. In the **Bluebeam Revu** section check the **Use as Default PDF Viewer** checkbox, then click **OK**.
Stapler

Windows Explorer Context (right-click) menu

In Windows Explorer, you are able to select files and right-click to Combine Files or Convert Files in Revu using Stapler.

Step 1: Browse in Windows Explorer to a folder containing the files you want to Convert or Combine.

Step 2: Select the files in the Explorer window.

Step 3: Right-click on any of the selected files and choose Combine Files in Revu or Convert Files in Revu.

Combine Files in Revu will create a single multipage PDF from the selected files.

Convert Files in Revu will make individual PDF from each of the selected files.

1. When Combine Files in Revu is selected, Stapler will be invoked with the files chosen already populated in the source file window.

2. Enter the name of the Output File.

3. Change the Custom Output Folder if needed.

1. When Convert Files in Revu is selected, Stapler will be invoked with the files chosen already populated in dialog.

2. Select the Staple button and the files will be converted to PDF and opened in Revu.
Combining

Creating a PDF from Multiple PDFs

To create a PDF from multiple existing PDFs, use the Combine command or the context menu in Windows Explorer.

Combine Command

- On the Command Bar, click the File tab, then click Combine.
- In the Combine PDF Files window, add files to the list.
  - Click Add Open Files to add currently open files to the list.
  - or-
  - Click Add, select the files in the Select files dialog, and then click Open.
- The Combine PDF Files dialog will list the PDFs in the order in which they will be combined.
  - Click the ▲ sort button to sort files by Name, Path, Date, etc.
  - Re-order individual files in the list by clicking the ▲ and ▼ buttons.
  - Click X Delete to remove a file from the list.
- When finished adding files, click OK to combine the PDFs.
Options:

Include Bookmarks: Add any bookmarks from the selected PDF files.

Include File Attachments: Add any file attachments from the selected PDF files.

Merge Document Properties: Combine the document properties of the existing and selected PDF files.

Merge Layers: All layer information in the PDFs will be kept when this option is checked. If unchecked, the layers will be removed, but the content and markups in the layers will remain in the combined PDF.
Studio Session Best Practices

- Name your **Session Name** with the Project Number - Milestone. This will help you and others identify a specific session if your session list has multiple active sessions in it.

  *Example: KA-3085-01 - Field Check*

- In the **Message** area of the **Session Invitation** dialog, type a message to all attendees that clearly explains what the Studio Session is intended for.

- Before changing the session permissions make sure that everyone in the Studio Session has their status set to Finished. Once all attendees have this completed, set the Markup on the Permissions tab to Deny. After this is completed, send an email to all attendees with an explanation of how long you intend to leave the Session available for saving archive copies and printing the final PDF.